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Kerio Connect client

Kerio Connect client

Kerio Connect client is a web client designed to speed up your work.

The following sections will guide you through all the features of the interface.

Kerio Connect client is available in Kerio Connect 8.0 and newer.

To see all articles about Kerio Connect client, read the articles in the Kerio Connect client

category.

Email

In the Email section in Kerio Connect client you can:

• Use fulltext search — just type in what you need and search through messages, email

addresses, subjects

• Receive less spam — have you received a spam message? Just click on the Spam button

and Kerio Connect will remember

• Add attachments easily — just drag & drop an attachment into any grey area

• Get automatic email address suggestions

• Save drafts automatically — start a message, go to another folder and come back to

finish the message

• Customize your out of office message with text and exact time

• Create filters to sort your messages to folders as they arrive

• Stay on top of new messages with desktop notifications even if you are not currently

working with Kerio Connect client

• Digitally sign and encypt messages

http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/category/kerio-connect/email-clients/kerio-connect-client/
http://kb.kerio.com/1331
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Calendar

In the Calendar section in Kerio Connect client you can:

• Create events in seconds — just double-click inside your calendar and create an event

• Invite other people to your meeting

• See immediately who is available (Free/Busy calendar)

• Set reminders for your events

• Create repeated events

• Share calendars with other people

• See calendars that other people have shared with you

http://kb.kerio.com/1575
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Contacts

In the Contacts section in Kerio Connect client you can:

• Create contacts easily

• Organize contacts into groups

• Share contacts with other people

• See contacts that other people have shared with you

http://kb.kerio.com/1309
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Tasks

In the Tasks section in Kerio Connect client you can:

• Create tasks and sort them into groups

• Share task groups with other people

http://kb.kerio.com/1290
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Notes

In the Notes section in Kerio Connect client you can:

• Write color-coded (multi-colored) notes

• Share notes with others

• Send notes as email messages with one click

http://kb.kerio.com/1291
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Configuring your Kerio Connect client

What to configure in your Kerio Connect client

Kerio Connect client is available in Kerio Connect 8.0 and newer.

In Kerio Connect client, users can configure the following settings:

• email signature

• Out of Office message (read article Configuring the Out of Office message)

• mail filters (read article Sorting email messages in Kerio Connect client)

• interface language and time zone

• customize the appearance

• notifications for new messages and event/task reminders (read article Enabling

notification in Kerio Connect client)

• their password (if allowed) and view their store quota

Configuring email signature

In Kerio Connect client, you can create a signature which will be automatically appended to

every message you write.

1. Click on your name in Kerio Connect client and select Settings.

2. Go to section Email → Signature.

3. Enter whatever you wish to be appended to each of your messages and confirm.

You can also use HTML code to append your signature (new in Kerio Connect 8.1).

http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-the-out-of-office-message-1315.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/sorting-email-messages-in-kerio-connect-client-1204.html
http://kb.kerio.com/1470
http://kb.kerio.com/1470
http://kb.kerio.com/1470
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/enabling-notifications-in-kerio-connect-client-1316.html
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Setting messages as read

You can specify time after which each message will be marked as read.

1. Click on your name in Kerio Connect client and select Settings.

2. Go to section Email → Reading.

3. Check option Mark displayed messages as read and select Immediately or set time

interval.
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4. Save.

You can also mark messages as read manually by clicking the colored dot next to the message.

Setting language

Kerio Connect client is available in the following languages: Czech, English (US and UK),

Chinese, Croatian, Dutch, French, German, Hungarian, Italian, Japanese, Polish, Portuguese,

Russian, Slovak, Spanish, and Swedish.

To select a language for your interface:

1. Click on your name in Kerio Connect client and select Settings.

2. In section Language and time, select your preferred language.

3. Save the settings.
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All items, such as messages, contacts, events and tasks, in all folder types will also

be sorted by the alphabet of this language.

Each language also has its own rules for displaying time and date. See the following section

for more details.

Configuring time

Time settings are important for correct time when sending and receiving messages.

By default, Time zone settings are based on Kerio Connect server. If you plan to use Kerio

Connect client in a time zone different from the server location, you can change the time

settings:.

1. Click on your name in Kerio Connect client and select Settings.

2. In section Language and time, select your preferred time zone.

3. Select Set your locales according to ... to display date and time (i.e. locales) according to

your preferred language.

If you wish to use other rules, select the language for your locale.

4. Save the settings.
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Setting email addresses

In Kerio Connect client, you can set you From and Reply-To addresses.

1. Click on your name in Kerio Connect client and select Settings.

2. Go to section Email → Composing.

3. Enter Default From address and/or Special Reply-To address.

4. Save.

When you compose a message, you can select the From address from a drop-down menu.

Changing your password

To change your account password:

1. Login to Kerio Connect client securely via HTTPS.

2. Click on your name in Kerio Connect client and select Settings.
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3. In section Password Change, type in your current and your new password.

4. Save the settings.

If this option is not available at all, contact your administrator.

Displaying account quotas

If you receive messages with large attachments or have a lot of contacts, you may soon use up

the quotas assigned for your account.

The limitations include:

• space available for you

• number of items allowed

If you wish to see how much space you use:

1. Click on your name in Kerio Connect client and select Settings.

2. Go to section My Quota.

3. There you can see how much space your account occupies, how many items you have and

what are you limitations.
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What to do when the quota is used up

If you reach any of the limits set for your account, you will not be able to receive new messages.

Once you reach 90% of a quota, a warning message will be displayed in the top bar of Kerio

Connect client.

To solve this problem, we recommend the following:

• delete messages in folders Sent and Trash (unless you need them)

• delete any other messages you do not need (especially with large attachments)

• ask your administrator to turn on automatic items clean-out (which will automatically

delete old messages and messages from Trash)

• ask your administrator to add some space for your account
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Customizing appearance of Kerio Connect client

About customizing

To customize the appearance of their Kerio Connect client, users can:

• change the color theme

• select the position of message preview pane

• hide the folders menu

Changing color theme

Default color of Kerio Connect client is blue. To select a different color theme, click your name

in Kerio Connect client and select Change theme.
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This feature is available in Kerio Connect 8.1 and newer.

Previewing messages

In Kerio Connect client, you can select whether you want to display previews of email messages

and where.

1. Click your name in Kerio Connect client and select Settings.

2. Go section Email.

3. In Preview pane, select the position of the pane.

You can also disable it.

4. Save the settings.

Hiding the folders menu

To save some space, you can hide the folder tree on the left. Click on the blue arrow

button under the Search box.

You can hide the tree regardless of the position of the preview pane.



3.4 Hiding the folders menu

23



24

Configuring the Out of Office message

Configuring the Out of Office message

Out of Office message is an automatic reply which is sent from your account when you receive

a message.

If you plan to go on holiday, you may want to let your business partners and customer know

that you are away. To do so, you can configure an out of office message.

1. Click your name in Kerio Connect client and select Settings.

2. In section Out of Office, check option Send "Out of Office" messages .

3. Write your message.

4. You can specify a time period when this automatic reply will be sent.

5. Save the settings.
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Kerio Connect sends the out of office message to each sender only once.
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Sending message in Kerio Connect client

Sending email messages

To send a message, you can:

• create a new message

• reply to a received message

• forward a message

Composing new messages

To compose a new email message, follow these steps:

1. In Kerio Connect client, click on the Compose button above the list of incoming messages.

This will open an editing window in your Kerio Connect client.

To open the message in a new browser window, click on

2. Select from which of your addresses you want to send the message.

If this option is not available, read the Defining addresses section in this article.

3. In the To: and CC: text box, write email addresses of recipients. As you type, Kerio Connect

client will offer you addresses from your contact lists.

If you wish protect privacy of some recipients, you can hide their email

address by using the blind copy — click Options → Bcc and enter email address

in the Bcc text box.
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4. Type the Subject of your message.

5. Write your message in the main text area.

If you specify a signature in your settings, Kerio Connect client automatically adds the

signature to each message.

6. Add attachments — drag and drop files from your computer to the compose window or

click on Attach and select files.

7. Click Options to add blind copy recipients, give the message a high priority or request a

read receipt (Confirm reading).

8. Click the Sign the message icon to add a digital signature to your message.

9. Click the Encrypt the message icon to send an encrypted message.

10. Click Send.

http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-signature
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-signature
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-signature
http://en.wikipedia.org/wiki/Blind_carbon_copy
http://en.wikipedia.org/wiki/Blind_carbon_copy
http://en.wikipedia.org/wiki/Email_tracking#Read-receipts
http://en.wikipedia.org/wiki/Email_tracking#Read-receipts
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
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Kerio Connect client regularly saves drafts of your messages. If you want to send your message

later, click Save — the message is saved to your Drafts folder.

Kerio Connect client does not support spell checking at the moment.

Defining addresses

When sending a message, you can set From and Reply-To addresses.

Reply-To address

To set a special Reply-To address:

1. Click your name in the top right corner and select Settings.

2. Go to Email.
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3. In the Composing section, type an email address in the Special Reply-To address

field.

This address will be used as a Reply-To address for all messages you send.

4. Save the settings.

From address

When composing a message, you can select from which address Kerio Connect sends the

message.

These address are defined in:

• Kerio Connect client — you can change your Default From address (Settings →

Email → Composing), and/or send messages on behalf of another user (if you

are a delegate).

• Kerio Connect administration — user account settings (tab Email addresses).

Ask your administrator to change your settings.

Replying to messages

If you wish to reply to a message, click on the Reply button. If the message has multiple

recipients, you can click on Reply All.

Kerio Connect client will automatically add Re: before the message subject and append the

original message to the message body.

http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1493
http://kb.kerio.com/1125
http://kb.kerio.com/1125
http://kb.kerio.com/1125
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You can edit the message before sending.

Forwarding messages

If you wish to forward a message, click on More → Forward.

Kerio Connect client will automatically add Fwd: before the message subject and append the

original message to the message body.

Add recipients and edit the message before sending.

Click Edit as New to send the original message you received.

Creating events from messages

You can create an event and invite all the recipients and senders from a message. Read article

Using calendars in Kerio Connect client.

http://kb.kerio.com/1575#sect-eventfromeemail
http://kb.kerio.com/1575#sect-eventfromeemail
http://kb.kerio.com/1575#sect-eventfromeemail
http://kb.kerio.com/1575#sect-eventfromeemail
http://kb.kerio.com/1575#sect-eventfromeemail
http://kb.kerio.com/1575#sect-eventfromeemail
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Sorting email messages in Kerio Connect client

About sorting

In Kerio Connect client, you can sort:

• messages in individual folders according to different criteria.

• received messages into folders in your mailbox, or

Sorting messages within a folder

In Kerio Connect client, you can sort messages according to various criteria.

Kerio Connect client remembers your sorting preferences in each individual folder.

Preview pane on the right

1. Go to a folder where you want to sort the messages.

2. Click on the sorting icon

3. Select how to sort the messages.
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If you want to sort messages in the reversed order, repeat the same procedure (e.g. if you sort

messages by clicking on Date and you want to reverse the order, click on Date again).

Preview pane on the bottom or hidden

To sort messages, click on any header of the message list.

If you want to sort messages in the reversed order, repeat the same procedure (e.g. if you sort

messages by clicking on the Received header and you want to reverse the order, click on the

Received header again).

Sorting messages into folders

Messages delivered to Kerio Connect client are stored in folder Inbox.

If you have additional folders, you can move messages:

• manually — drag messages/folders to another folder

• automatically — sort messages using filters

Creating filters

To sort messages to folders automatically, you can create filters:

1. Click on your name in Kerio Connect client and select Settings.

2. In section Filters, click New Filter.

3. To display all filter settings, click icon

4. Set the filter.
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5. You can check option Skip other rules.

6. Save the settings.

You can drag filters to sort the list.

Using filters

Kerio Connect client checks all delivered messages against all the filters.

• The order of filters is important — the filter on top of the list is applied first.

• If Skip other rules is active, no more filters are applied.
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Example 1:

Mr. Powaro receives message Dept. meeting from Hector Mouse (email address

mouse@feelmorelaw.com).

Kerio Connect checks the filters from 1 to 4:

1. Filter 1 forwards messages with subject Press conference to regret@feelmorelaw.com.

As the subject is not Press conference, this filter does not apply and Kerio Connect

continues with filter 2.

2. Filter 2 marks messages from archive@feelmorelaw.com as read.

As the sender is not archive@feelmorelaw.com, this filter does not apply and Kerio

Connect continues with filter 3.

3. Filter 3 moves messages from mouse@feelmorelaw.com to folder Pathology

department.

This condition is met. The message is moved to folder Pathology department.

In the filter 3 definition, option Skip other rules is enabled. Kerio Connect applies filter

3 and skips other filters.
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Example 2:

Creating a filter for forwarding incoming messages to another address.
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Enabling notifications in Kerio Connect

How to get notified about upcoming events and tasks

Kerio Connect client can remind you about

• upcoming events and tasks via reminders

• new messages and upcoming events and task via desktop notifications and pop-up

notifications

Event and task reminders

Reminders for your calendar events and tasks are displayed automatically in the top bar of

your Kerio Connect client — no additional settings are required.

http://kb.kerio.com/product/kerio-connect/kerio-connect-client/using-tasks-in-kerio-connect-client-1290.html
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/using-tasks-in-kerio-connect-client-1290.html
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The reminders can be accompanied by a sound. To enable or disable the sound reminders:

1. Click on your name in Kerio Connect client and select Settings.

2. In section Reminders, select option Use sound when reminding about events and tasks.

3. The settings are saved automatically.

Once a reminder appears:

• click on it to be guided to the appropriate section in Kerio Connect client (Mail,

Calendar, Task) and display it in detail

• move mouse over the reminder for options to dismiss or postpone the reminder

Desktop notifications

Desktop notifications are small pop-up windows which appear on your screen when using the

following browsers:

• Chrome

• Safari 6 and newer

To display desktop notifications:

1. Enable the desktop notifications in your browser. The following links will guide you to the

individual browser settings for enabling desktop notifications:

• Google Chrome

• Safari

2. Click on your name in Kerio Connect client and select Settings.

3. In section Reminders, select the types of notifications (messages and/or events and tasks).

http://support.google.com/mail/bin/answer.py?hl=en&answer=1075549
http://support.google.com/mail/bin/answer.py?hl=en&answer=1075549
http://support.apple.com/kb/PH11953
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These options are visible only if notifications are enabled in your browser.

4. Test Notification to make sure it works.

5. The settings are saved automatically.

Once a notification appears on your screen, click on it and the new message (event/task) will

be displayed in detail.

Pop-up notifications

Pop-up notifications are small pop-up windows which appear on your screen when using the

following browsers:

• Safari 5 and older

• Mozilla Firefox

• Microsoft Internet Explorer

To display pop-up notifications:

1. Disable the pop-up blocker in your browser (or add an exception for your Kerio Connect

address). The following links will guide you to the individual browser settings for disabling

pop-up blockers:

• Mozilla Firefox

• Microsoft Internet Explorer

• Safari

2. Click on your name in Kerio Connect client and select Settings.

3. In section Reminders, select the types of notifications (messages and/or events and tasks).

http://support.mozilla.org/en-US/kb/pop-blocker-settings-exceptions-troubleshooting#w_pop-up-blocker-settings
http://support.mozilla.org/en-US/kb/pop-blocker-settings-exceptions-troubleshooting#w_pop-up-blocker-settings
http://windows.microsoft.com/en-US/Windows7/Internet-Explorer-Pop-up-Blocker-frequently-asked-questions
http://windows.microsoft.com/en-US/Windows7/Internet-Explorer-Pop-up-Blocker-frequently-asked-questions
http://windows.microsoft.com/en-US/Windows7/Internet-Explorer-Pop-up-Blocker-frequently-asked-questions
http://support.apple.com/kb/PH5040


7.4 Pop-up notifications

39

These options are not visible unless you disable the pop-up blocker.

4. Test Notification to make sure it works.

5. The settings are saved automatically.

Once a notification appears on your screen, click on it and the new message (event/task) will

be displayed in detail.
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Resetting your mobile device in Kerio Connect

client

Managing your devices

New in Kerio Connect 8.3!

Kerio Connect client shows all Exchange ActiveSync mobile devices (mobile phones, tablets)

connected to your Kerio Connect account.

Click your name in the top right corner and select Settings → Mobile Devices.

Resetting your devices

If you lose your device or the device is stolen, you can protect your personal data by deleting

all the data from the device. This action is also called remote wipe.

1. In Kerio Connect client, click your name in the top right corner and select Settings.

2. Go to the Mobile devices section.
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3. In the list of mobile devices, find the device you want to reset and click Reset Device.

4. Type your Kerio Connect client password to confirm the reset.

This action resets your device to factory settings. All data, including

photos, videos, music, calendars, emails, will be deleted from your device.

5. Once the device connects to the Kerio Connect server, all data will be removed from the

device.

You can cancel the reset before the device connects to the Kerio Connect server (click

Cancel).

6. When the reset is complete, select the device and click Remover Device to delete the

device from the list.

If your device is lost or stolen, we recommend changing your Kerio Connect password

after you reset your device.
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Support for encrypted and digitally signed mes-

sages in Kerio Connect client

Details

New in Kerio Connect 8.3!

In Kerio Connect client, you can:

• sign your messages

• encrypt your messages

• display encrypted messages you receive

Kerio Connect uses the S/MIME standard to sign and encrypt the messages.

Encypting and signing messages

To sign and/or encrypt messages, you must:

1. Initialize your certificate store

2. Acquire and import your personal certificate to your Kerio Connect client

3. Sign and/or encrypt messages you send (and display (decrypt) secured messages you

receive)

http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://en.wikipedia.org/wiki/S/MIME
http://en.wikipedia.org/wiki/S/MIME
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1581
http://kb.kerio.com/1579
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Initializing certificate store in Kerio Connect client

Details

New in Kerio Connect 8.3!

Before you can digitally sign and/or encrypt messages, you must initialize your certificate

store.

Initializing your certificate store

1. Log in to your Kerio Connect client securely via HTTPS.

2. Click your name and select Settings.

3. Go to the Secure Messages section.

4. Create a password for the certificate store.

You can:

• use the same password as for your Kerio Connect client

• create a unique password for the certificate store (more secure option)

http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1579
http://kb.kerio.com/1579
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Remember your password well. Read the Resetting your password section

for more information.

5. Import your personal certificate.

If your store is initiated and your certificate imported, you can digitally sign and encrypt

(decrypt) messages.

For general info on this security feature, read the Support for encrypted and digitally signed

messages in Kerio Connect client article.

Changing your certificate store password

You can change the password to your certificate store anytime.

1. In Kerio Connect client, click your name and select Settings.

2. Go to the Secure Messages section.

3. In Certificate store protection, you can:

• change the type of the password (same as for Kerio Connect client or different)

• change the password

http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1581
http://kb.kerio.com/1581
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http://kb.kerio.com/1579
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
http:/kb.kerio.com/1594
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Resetting your certificate store password

If you forget the password to your certificate store, you must initialize the store again.

1. Login to Kerio Connect client, click your name and select Settings.

2. Go to the Secure Messages section.

3. Click the Forgotten password? link.

4. Click Continue.

5. Enter your Kerio Connect client password and click Reset.
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6. Initialize your certificate store again.

7. Import all your certificates.

http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
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Importing personal certificates to Kerio Connect

client

About personal certificates

New in Kerio Connect 8.3!

If you want to send encrypted or digitally signed messages, you must import a personal

certificate into Kerio Connect client.

To acquire a personal certificate:

• ask your administrator to get you one, or

• download your own certificate from one of the free servers (e.g. Comodo or Instant

SSL)

You must have personal certificates for each of your email addresses including any aliases.

Back up your certificates so you can use them when re-initializing your certificate

store.

Importing personal certificates into Kerio Connect client

1. Login to Kerio Connect client securely, click your name and select Settings.

2. Go to the Secure Messages section.

3. Login to your certificate store.

4. In the Secure Messages section, click Import.

http://kb.kerio.com/1594
http://kb.kerio.com/1594
http://kb.kerio.com/1594
http://kb.kerio.com/1594
http://kb.kerio.com/1594
http://www.comodo.com/home/email-security/free-email-certificate.php
http://www.instantssl.com/ssl-certificate-products/free-email-certificate.html
http://www.instantssl.com/ssl-certificate-products/free-email-certificate.html
http://kb.kerio.com/1580
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5. Browse for the certificate file, type the passphrase and click Import.

The server verifies the validity of the certificate. If the certificate is not valid, ask your

administrator to upload a root certificate to the server.

6. Repeat for all your certificates.

http://kb.kerio.com/
http://kb.kerio.com/
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Displaying certificate details

To display details about your certificate, such as the serial number and validity, click the

certificate menu and select Details.
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Downloading your certificate

To download your certificate, click the certificate menu and select Download.
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Download and back up your certificates so you can use them when re-initializing your

certificate store.

Deleting your certificate

To download your certificate, click the certificate menu and select Delete.

http://kb.kerio.com/1580
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Digitally signing messages in Kerio Connect client

Overview

New in Kerio Connect 8.3!

If you add your digital signature to your messages, the recipients know that you personally

have sent the message and the message has not been changed during the delivery.

Prerequisites

Before you can sign your messages digitally, you must:

• initialize your certificate

• import a valid personal certificate

Digitally signing messages

1. Log in to your Kerio Connect client securely via HTTPS.

2. Compose a message.

3. Click the Sign the message button.

You must enter the password for your certificate store.

4. Send the message.

http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1580
http://kb.kerio.com/1580
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Signing all messages automatically

Kerio Connect client can sign all your outgoing messages automatically.

1. Log in to your Kerio Connect client securely via HTTPS.

2. Click your name and select Settings.

3. Go to the Secure Messages section.

4. In the Mail settings, select the Sign all outgoing messages option.

5. Save the settings.
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Encrypting messages in Kerio Connect client

Overview

New in Kerio Connect 8.3!

If you encrypt your messages, only the message recipients can read your messages.

Prerequisites

To encrypt messages, you must:

• initialize your certificate store

• import a personal certificate

• have a public certificate of the recipient

To acquire a public certificate of another user, ask them to send you a digitally signed

message and reply to such message.

Encrypting messages

1. Compose a message.

2. Click the Encrypt the message icon.

If your certificate store is locked, enter your certificate store password.

3. Send the message.

http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1578
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1331#sect-composenew
http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
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Reading encrypted messages

To read an encrypted message, click the Display button.
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If your certificate store is locked, enter your certificate store password first.

Displaying encrypted messages directly

If you do not want to click the Display button in every encrypted message you receive, Kerio

Connect client can do it automatically.

1. Login to Kerio Connect client securely, click your name and select Settings.

2. Go to the Secure Messages section.

3. Login to your certificate store.

4. In the Secure Messages section, select the Display decrypted messages directly option.

http://kb.kerio.com/1580
http://kb.kerio.com/1580
http://kb.kerio.com/1580
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From now on, Kerio Connect client displays all your messages directly.
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Using contacts in Kerio Connect client

Creating contacts

To create a new contact:

1. In Kerio Connect client, go to the Contacts section .

2. Click New → Contact.

3. Fill in any information.

4. Click Add to add additional information.

To add items of already displayed information, click the plus sign at the right of an item.

5. Click add photo and select the contact photo.

The image file must be in the JPG format and cannot exceed 256 kB.

6. Click Save to save the contact.
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Creating contact groups

Contact groups (previously called distribution lists) are groups of email addresses used for

sending messages to multiple users.

1. In Kerio Connect client, go to the Contacts section .

2. Click New → Contact Group.
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3. Fill in the group name.

4. In the Add field, type an email address and click Enter.

As you type, Kerio Connect suggest users from your contact folders.

You can add a single email address or a contact groups.

5. Add as many email addresses as you wish.

6. Click Save to save the contact group

Apple OS X does not support distribution lists — contact groups are not synchronized

to Address Book and vice versa.

Editing contacts

To edit your contacts or contact groups, double-click the contact in the list and make edits.

You can edit:

• contacts you created in Kerio Connect client,

• public contacts if you have appropriate rights,

• contacts shared with you if you have appropriate rights.

http://kb.kerio.com/1171#sect-assignrights
http://kb.kerio.com/1171#sect-assignrights
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Deleting contacts

There are two ways to delete a contact:

1. Go to the Contacts section .

2. Select the contact.

3. Click the Trash icon.

Or

New in Kerio Connect 8.3!

1. Go to the Email section .

2. Click Compose.

3. Type the email address you want to delete.

4. In the list of offered email addresses, click the delete icon next the contact you want to

delete.
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This procedure can also delete autocreated contacts (contacts to which you send messages

and which are not in your personal or public contact folders).

To delete contact folders shared with you, you must have appropriate rights.

Sorting contacts

In Kerio Connect client, contacts are sorted according to contact’s Last name.

If the last name entry contains more names, the first one is used for sorting.

Sorting contacts into folders

Your default contact folder is My contacts.

To add another folder, click the plus sign next to Folders and specify a name.

To move contacts to different folders, drag & drop a contact from its original folder to another

in the navigation tree on the left.

Sharing your contact folders

You can share your contact folders with other users.

1. Right-click a folder and click on Sharing.

2. To share with a single user, select User and type their name or email.

To share with a group, select Group of users and select a group.

To share with everyone in your company, select Everyone from <your domain>.
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3. Specify the sharing rights:

• can view

• can change — user can add, delete and edit the contacts

• is owner — can set sharing, can add, delete and edit the contacts

4. Repeat steps 2 and 3 as needed.

5. Click OK.

Displaying shared contact folders

If someone shares a contact folder with you:

1. In the Kerio Connect client, go to the Contacts section .

2. Click the plus sign next to Shared folders.

3. In the list of available folders, click those you want to display.

Now you can work with the shared contacts.
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Using tasks in Kerio Connect client

Creating tasks

To create a new task:

1. In Kerio Connect client, go to the Task section .

2. Specify the task in the Enter a new task field.

3. Click Add.

Double-click the task to:

• add reminder date and time (for info on reminders, read article Configuring your Kerio

Connect client)

• add notes about the task

Once you are done, Save the task.

http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-remindnotify
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-remindnotify
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-remindnotify
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-remindnotify
http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-remindnotify
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Working with tasks

The task section allows you to:

• sort your task into folders.

• mark tasks as complete (click the white square on the left side)

Finished tasks can be viewed in the Completed tasks section.

To remove a task, right-click the task and select Delete.

Sorting tasks into folders

Your default task folder is My tasks.

To add another folder, click the plus sign next to Folders and specify a name.

To move tasks to different folders, drag & drop a task from its original folder to another in

the tree on the left.

Sharing your task folders

You can share your tasks folders with other users.

1. Right-click a folder and click on Sharing.

2. To share with a single user, select User and type their name or email.

To share with a group, select Group of users and select a group.

To share with everyone in your company, select Everyone from <your company>.

3. Specify action users can do:

• can view

• can change — user can add, delete and edit the tasks

• is owner — can set sharing, can add, delete and edit the tasks

4. Repeat steps 2 and 3 as needed.

5. Click OK.
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Displaying shared folders

If someone shares you a task folder:

1. In Kerio Connect client, go to the Task section .

2. Click the plus sign next to Shared folders.

3. In the list of available folders, click those you want to see in your task section.

Now you can work with the shared task.
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Using notes in Kerio Connect client

Creating notes

To create a new note:

1. In Kerio Connect client, go to the Notes section .

2. Click New Note.

3. Write your note in the colored text area.

Notes are saved automatically.

Editing notes

To edit a note, select the note in the list and edit directly in the text area.

Sending notes as email messages

Kerio Connect client enables you to send your note as an email message with one click.

1. In the Notes section in Kerio Connect client, select a note.

2. Click Send as Message.

This will open a new message window containing the text from the note.
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3. Add recipients and other info.

4. Send.

Your signature will be automatically added.

Working with notes

The notes section allows you to:

• sort your notes into folders.

• change the color of your note (right-click a note and select a color).

• remove a note (right-click the note and select Delete).

Sorting notes into folders

Your default notes folder is My notes.

To add another folder, click the plus sign next to Folders and specify a name.

To move notes to different folders, drag & drop a note from its original folder to another in

the tree on the left.

Sharing your notes folders

You can share your notes folders with other users.

1. Right-click a folder and click on Sharing.

2. To share with a single user, select User and type their name or email.

To share with a group, select Group of users and select a group.

To share with everyone in your company, select Everyone from <your company>.

3. Specify action users can do:

• can view

• can change — user can add, delete and edit the notes

• is owner — can set sharing, can add, delete and edit the notes

4. Repeat steps 2 and 3 as needed.

5. Click OK.

http://kb.kerio.com/product/kerio-connect/kerio-connect-client/configuring-your-kerio-connect-client-1196.html#sect-signature
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Displaying shared folders

If someone shares you a notes folder:

1. In Kerio Connect client, go to the Notes section .

2. Click the plus sign next to Shared folders.

3. In the list of available folders, click those you want to see in your notes section.

Now you can work with the shared notes.



71

Using delegation in Kerio Connect client

About delegation

Delegation is an advanced typed of sharing. A delegate can act on your behalf — they can

send/confirm your event invitations, and/or send/receive your messages.

To delegate users:

1. Assign delegation rights to users (delegates).

You can delegate only individual users (not a group of users).

2. Delegates then act on your behalf

Delegation includes:

• Inbox

• Main calendar

Use the traditional sharing feature to share contacts, notes and tasks.

Delegating users

You can delegate as many users as you wish.

Kerio Connect 8.3.2 and newer

1. In Kerio Connect client, click your name and select Settings.

2. Go to the Delegation section.

3. Click the plus sign and type the name or email address of a user. Kerio Connect client will

offer users as you type → select a delegate.

http://kb.kerio.com/1502
http://kb.kerio.com/1502
http://kb.kerio.com/1502
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4. By default, you allow delegates access only to your calendar (delegates can send and accept

event invitations).

To allow access to your Inbox, click the menu icon and select Access to Inbox.

5. Save the settings.

Kerio Connect 8.2.0 — 8.3.1

1. In Kerio Connect client, click your name and select Settings.

2. Go to the Delegation section.

3. In the Delegates who can act on my behalf box, type the name or email address of a user.

Kerio Connect client will offer users as you type → select a delegate.

4. Save the settings.
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Removing delegation

If you want to remove delegation rights from a user:

• Kerio Connect 8.3.2 and newer — click the menu icon and select Remove

• Kerio Connect 8.2.0-8.3.1 — click the x sign next to a delegate’s name.

Accepting delegation

When somebody delegates you to act on their behalf, you automatically become a delegate.

Kerio Connect client will display the person’s Inbox and Calendar (see section Using

delegation).

You cannot reject delegation, however you can hide the delegated folders:

Hiding a delegated Inbox

Right-click a delegated Inbox and select Hide.
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You are still a delegate, i.e. you can send messages on the person’s behalf, but you cannot see

their Inbox.

Hiding all delegated folders

1. In Kerio Connect client, click your name and select Settings.

2. Go to section Delegation.

3. In the People I am a delegate for box, uncheck the appropriate box.

4. Save the settings.

You cannot send messages and create/accept events on another person’s behalf.

Check this box again to renew your delegation rights.

Using delegation

See the following examples on how to use delegation in Kerio Connect.

Delegating users

R.Cul Powaro has delegated Meg Regret to act on his behalf.
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Meg automatically become a delegate and her Kerio Connect client displays Mr. Powaro’s Inbox

and Calendar.
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Sending and receiving emails

Meg Regret wants to send a message on behalf of Mr. Powaro. She selects Mr. Powaro’s address

from the drop-down menu when composing a message.

When Mr. Maison receives the message, he can see that Mr. Powaro has delegated Meg Regret

to act on his behalf.
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Creating and accepting calendar events

Meg Regret wants to create an event on behalf of Mr. Powaro. She selects Mr. Powaro’s

calendar from the drop-down menu when creating an event.

When Mr. Maison receives the invitation, he can see it was sent by Mr. Powaro.

Mr. Maison invites Mr. Powaro to a meeting. Meg Regret sees the invitation sent to Mr. Powaro

and can accept it on Mr. Powaro’s behalf.
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A delegate cannot create private events on another person’s behalf. Nor can they

see/edit the person’s other private events.
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Sharing in Kerio Connect client

About sharing

In Kerio Connect client you can share any folder in any section with other users.

First, you assign sharing rights to users. Second, users subscribe to shared folders.

Sharing email folders

1. In your email section in Kerio Connect client, right-click a folders and select Sharing.

2. Select with whom to share:

• user — type a name or email address (Kerio Connect client will offer a list of users)

• group of users — select from a list of groups

• everyone from your domain

• everyone from server — only available if public folders are set as Global for all

domains

3. Select the level of rights:

• can view — users cannot edit messages

• can change — users can edit messages

• is owner — users can edit messages and change sharing rights

4. You can Set the rights also for subfolders.

Any subfolders created after you set sharing will not be included.

5. Save the settings.

http://kb.kerio.com/1171
http://kb.kerio.com/1171
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Sharing calendars

1. In your calendar section in Kerio Connect client, right-click a calendar and select Sharing.

2. Select with whom to share:

• user — type a name or email address (Kerio Connect client will offer a list of users)

• group of users — select from a list of groups

• everyone from your domain

• public — no login required for displaying the calendar

3. Select the level of rights:

• can view — users cannot edit events

• can change — users can edit events

• is owner — users can edit events and change sharing rights

Only the original owner can change events with more attendees. To edit

events with more attendees, use delegation instead of sharing.

If you share your calendar publicly, Kerio Connect client assigns the can view rights (these

settings cannot be changed).

4. Save the settings.

http://kb.kerio.com/1493
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Sharing contacts, notes and task folders

1. In your calendars/notes/tasks section in Kerio Connect client, right-click a folder and

select Sharing.

2. Select with whom to share:

• user — type a name or email address (Kerio Connect client will offer a list of users)

• group of users — select from a list of groups

• everyone from your domain

3. Select the level of rights:

• can view — users cannot edit contacts/notes/tasks

• can change — users can edit contacts/notes/tasks

• is owner — users can edit contacts/notes/tasks and change sharing rights

4. Save the settings.

Removing sharing rights

Go to the sharing dialog of a folder and click the x symbol next to the user you wish to remove

from sharing.
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Subscribing to shared folders

• email, calendar, note and task folders — click the + symbol next to Shared Folders in

the left hand tree and select the folder to subscribe.

• calendar folders — click the + symbol next to People in the calendar list on the left

and select the calendar to subscribe.

If events also have attendees other than the original owner, you

cannot change such events regardless of your rights. To edit events with

more attendees, use delegation instead of sharing.

http://kb.kerio.com/1493
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Unsubscribing shared folders

Right-click a shared folder and select Hide.
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Synchronizing folders with mobile devices

Overview

In Kerio Connect client, you can select which folders will synchronize to your

iCal/CalDAV/CardDAV/Exchange ActiveSync clients.

Selecting folders to synchronize

1. Click your name in Kerio Connect client and select Settings.

2. Go to section Folders to Sync.

3. Select which folders will synchronize.

The icon will help you identify the type of each folder (emails, contacts, tasks, notes)

4. Save.

If you subscribe to shared or public folders, they will also be available in the list of folders to

synchronize.

http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1171
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If you synchronize your Kerio Connect account via Exchange ActiveSync to an iOS

device, the Drafts folder will not synchronize (due to the limitations of Exchange ActiveSync

and the iOS device).
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Making calls from Kerio Connect client

Overview

New in Kerio Connect 8.3!

In Kerio Connect client, you can call any number from a message or from contact details just

by cllicking the number.

If you have this feature available, you can see the Click to Call section in your Kerio Connect

client (click your name and select Settings).

If you don’t see the Click to Call section, contact your administrator. Administrators must

enable this feature on the server.

Making calls from Kerio Connect client

To make calls from Kerio Connect client:

1. Select the number you want to call:

• In a message, select a number. When the Call icon appears, click it.

• In contact details, click any phone number.

In contact

http://kb.kerio.com/1572
http://kb.kerio.com/1572
http://kb.kerio.com/1572
http://kb.kerio.com/1572
http://kb.kerio.com/1572
http://kb.kerio.com/1572
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2. 2. Select the extension you want to place the call from, and click Dial.

You can also set a default extension.

3. Your desk phone or softphone starts ringing. Answer the phone.

The phone of the person you are calling starts ringing.
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When the call is established, Kerio Connect client displays information about the call

duration in the bottom right corner.

4. End the call by clicking on the Hang up button or the end call icon.

Selecting a default extension

If you have more extensions in Kerio Operator, you can:

• select the extension before making each call

• define a default extension for all your calls

http://kb.kerio.com/906
http://kb.kerio.com/906
http://kb.kerio.com/906
http://kb.kerio.com/906
http://kb.kerio.com/906
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To select a default extension:

1. Click your name in Kerio Connect client and select Settings.

2. Go to the Click to Call section.

3. Click the Select default extension option and select the extension you want to make your

default from the list.

4. Save the settings.



90

Configuring clients for instant messaging

Recommended IM clients

Kerio instant messaging service is based on XMPP, an open technology for real-time

communication.

Kerio Connect recommends the following instant messaging clients:

• Pidgin for Microsoft Windows

• Psi for Linux

• Messages (iChat) for Mac OS X

Supported features

Kerio instant messaging service supports the following features:

• sending rich text messages

• presence notifications

• sharing files

• auto-populated contact list of your colleagues

• synchronization of contact photos

• auto-configuration on Mac

• audio/video calls (availability depends on your IM client)

• talking with multiple users in a single chat room (for more information on group chat,

read article Initiating group chat in instant messaging)

Configuring Pidgin for Microsoft Windows

To configure the Pidgin client, follow these steps:

1. Download and install Pidgin.

2. Run the application and click Accounts → Manage Accounts → Add.

3. Fill in the information — protocol (XMPP), your username and password, your domain.

4. Save the account.

http://en.wikipedia.org/wiki/Comparison_of_instant_messaging_clients
http://en.wikipedia.org/wiki/Comparison_of_instant_messaging_clients
http://kb.kerio.com/1487
http://kb.kerio.com/1487
http://kb.kerio.com/1487
http://kb.kerio.com/1487
http://kb.kerio.com/1487
http://kb.kerio.com/1487
http://www.pidgin.im/download/
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Configuring Messages on Mac OS X

To auto-configure Messages on Mac OS X, use Kerio Connect Account Assistant.

For manual configuration, follow these steps:

1. Go to Messages to Preferences → Accounts. and click the plus sign.

2. Fill in the information — protocol (Jabber), account name (you username including the

domain) and password.

3. Save the account.

Use similar settings for iChat.

http://kb.kerio.com/product/kerio-connect/os-x/kerio-connect-account-assistant-1399.html
http://kb.kerio.com/product/kerio-connect/os-x/kerio-connect-account-assistant-1399.html
http://kb.kerio.com/product/kerio-connect/os-x/kerio-connect-account-assistant-1399.html
http://kb.kerio.com/product/kerio-connect/os-x/kerio-connect-account-assistant-1399.html
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Configuring Psi on Linux

1. Download and install Psi.

2. Run the application and click General → Account Setup → Add.

3. Fill in the information — XMPP address (your username including the domain) and

password.

4. Save the account.

Contact lists

When you login to your account in an IM client for the first time, a list of all your Col-

leagues will be created. You can move them into other folders or delete them (see section

Troubleshooting on how to restore this contact list).

http://psi-im.org/download/
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You can create additional contact lists and add other contacts depending on the client you

use.

Troubleshooting

Contact list

If you have problems with your company contacts (Colleagues), ask your administrator to

restore your contact list.

Any change you have previously made to the Colleagues list will be lost. Your

external contacts will remain preserved.

Cannot connect to your account

If you cannot connect to your account, check your DNS settings for client auto-configuration

or configure the clients manually:

Pidgin

Go to Modify Account → tab Advanced and use one the following configurations:

• uncheck option Require encryption, add your server address and port 5222, or

• set Connection Security to Use old-style SSL, add your server address and port

5223

Messages

Go to Account Settings → tab Server Settings and use one the following configurations:

• uncheck option Use SSL, add your server address and port 5222, or

• check option Use SSL, add your server address and port 5223

Psi

Go to Modify Account → tab Connection, check option Manually Specify Host/Port and

use one the following configurations:

• set Encryption Connection to Always, add your server address (Host) and port

5222, or

• set Encryption Connection to Legacy SSL, add your server address (Host) and

port 5223

http://kb.kerio.com/product/kerio-connect/instant-messaging/configuring-dns-for-instant-messaging-1398.html#sect-configuresrvclient
http://kb.kerio.com/product/kerio-connect/instant-messaging/configuring-dns-for-instant-messaging-1398.html#sect-configuresrvclient
http://kb.kerio.com/product/kerio-connect/instant-messaging/configuring-dns-for-instant-messaging-1398.html#sect-configuresrvclient
http://kb.kerio.com/product/kerio-connect/instant-messaging/configuring-dns-for-instant-messaging-1398.html#sect-configuresrvclient
http://kb.kerio.com/product/kerio-connect/instant-messaging/configuring-dns-for-instant-messaging-1398.html#sect-configuresrvclient
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Initiating group chat in instant messaging

About group chat in instant messaging

If you use instant messaging in Kerio Connect and want to chat with multiple users and share

thoughts with all of them together, you can create a temporary chat room, i.e. group chat.

Kerio Connect does not require any additional settings to use group chats.

The server address for group chats is conference.[your_domain_name] , for example

conference.feelmorelaw.com.

This article describes group chat in:

• Pidgin for Microsoft Windows

• Messages for Mac OS X

• Psi for Linux

For information on initial configuration of instant messaging clients, read article Configuring

clients for instant messaging.

Pidgin for Microsoft Windows

Initiating group chat in Pidgin

1. In your Pidgin, click Buddies → Join a Chat.

2. Select account, type a room name, server, your nickname (Handle).

http://kb.kerio.com/1411
http://kb.kerio.com/1411
http://kb.kerio.com/1487#sect-pidgin
http://kb.kerio.com/1487#sect-pidgin
http://kb.kerio.com/1487#sect-pidgin
http://kb.kerio.com/1487#sect-pidgin
http://kb.kerio.com/1487#sect-messages
http://kb.kerio.com/1487#sect-messages
http://kb.kerio.com/1487#sect-messages
http://kb.kerio.com/1487#sect-messages
http://kb.kerio.com/1487#sect-messages
http://kb.kerio.com/1487#sect-psi
http://kb.kerio.com/1487#sect-psi
http://kb.kerio.com/1487#sect-psi
http://kb.kerio.com/1411
http://kb.kerio.com/1411
http://kb.kerio.com/1411
http://kb.kerio.com/1411
http://kb.kerio.com/1411
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3. Click Join.

4. To configure the chat room (e.g. secure the room with a password), click Configure Room

and set parameters.

You cannot change the parameters later.

5. Confirm the settings.

Inviting people to group chat in Pidgin

To invite people to a group chat, drag them from your contact list to the room list or click

Conversation → Invite.
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Joining and leaving group chats in Pidgin

If you receive an invitation, click Accept to join the group chat.

You can also search through existing chat groups by clicking on Buddies → Join a Chat →

Room List → Find Rooms.

To leave a room, close the chatroom window.

Messages for Mac OS X

Initiating group chats in Messages

To create a group chat, add at least two users to a conversation.

1. Initiate a conversation in Messages.

2. Add users to this conversation.

Users receive an invitation and you can start chatting.



Initiating group chat in instant messaging

98

Inviting people to group chats in Pidgin

To invite people to a multi user chat room, click the blue plus icon and invite users.

Joining and leaving group chats in Messages

To join a group chat, select it from the list of chats and click Accept.



22.4 Psi for Linux

99

To leave a chat room, delete it from the list of chats.

Psi for Linux

Initiating group chat in Psi

1. In your Psi, click General → Join Groupchat.

2. Type a conference host, room name, server, your nickname.

If you want to protect the chat room, type a password.
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3. Click Join.

4. To configure the chat room (e.g. secure the room with a password), click the down arrow

above the user list and select Configure Room.

5. Apply the settings.

Inviting people to group chat in Psi

To invite people to a group chat, select a person in your contact list and click Invite To.
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Joining and leaving group chats in Psi

To accept an invitation to a group chat, double-click the invitation text inside the event dialog

and click Join.
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To leave a room, close the chatroom window.
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Kerio Connect Account Assistant

About Kerio Connect Account Assistant

Kerio Connect Account Assistant is a single autoconfig tool which enables one-time

auto-configuration of the following applications on Mac OS X 10.6 or newer:

• Apple Mail & Notes (secure IMAP, SMTP Submission)

• Apple Calendar & Reminders (CalDAV)

• Apple Contacts (CardDAV)

• Apple Messages (XMPP)

• Microsoft Outlook for Mac (Exchange Web Services)

• Microsoft Entourage (WebDAV)

Using Kerio Connect Account Assistant

Kerio Connect Account Assistant is unique for each user. Download it from your own

integration page.

1. Open the Mac integration page (e.g. http://mail.feelmorelaw.com/integration).

You can also click your name in Kerio Connect client and select Integration with Mac.



Kerio Connect Account Assistant

104

2. Click on Set up my Mac and download Kerio Connect Account Assistant to your computer.
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3. Once the download finishes, the installation program gets started — confirm installation

and run it.

4. Select which products installed on your computer to configure (you can configure any of

them later) and click Continue.
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5. Enter your Kerio Connect client password and click Continue.

Now the configuration application verifies your identity and server connection.

6. Click Configure to run the configuration of the selected applications.

Now the configured applications are available and ready.

All previous configuration modules are available at the integration page, upon

clicking on See other options.
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Support for Apple iCal/Calendar using the CalDAV

standard

About CalDAV and Apple iCal/Calendar

CalDAV is an Internet standard which allows applications such as Apple iCal and Apple

Calendar to manage calendaring information on a remote server (Kerio Connect).

Kerio Connect supports the following CalDAV features:

• calendar availability (free/busy information)

• events with privacy tag

• scheduling (invitation requests)

From Kerio Connect 8.2, the fllowing features are also supported:

• per-folder sharing (without delegation)

• folder sharing notifications

• full delegation support

• custom labels for shared calendars

Configuring CalDAV account

Automatic configuration

Use Kerio Connect Account Assistant to automatically configure Apple iCal/Calendar accounts

on Mac OS X 10.5 or later.

Manual configuration

1. Run the Apple iCal/Calendar application.

2. In the menu, select iCal/Calendar→ Preferences and go to tab Accounts.

3. Click on the + button to create a new account.

4. Type your credentials and the location of your Kerio Connect server.

http://en.wikipedia.org/wiki/Caldav
http://kb.kerio.com/1399
http://kb.kerio.com/1399
http://kb.kerio.com/1399
http://kb.kerio.com/1399
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5. Confirm.

Sharing calendars

If you configure Apple iCal/Calendar with CalDAV, you can share individual calendars with

other users.

You can also use an advanced type of sharing — delegation. A delegate has full control over

your calendar and can also create and accept meeting invitations on your behalf.

To share a calendar:

1. Select a calendar you want to share from the list of your calendars.

2. In the menu, select Calendar → Share Calendar (Edit → Share Calendar on 10.8 and

above).

3. Click the + button to add users.

4. In the Privilege column, assign rights — Read only or Read & Write.
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Adding shared, public or resource calendar

Users assigned sharing rights receive a notification which invites them to join the shared

calendar.

If you accept the invitation, the calendar will be added to your calendar list.
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If you decline the invitation (or do not receive one), subscribe to the calendar in your Kerio

Connect client and select it for synchronization.

When user adds a shared calendar, they can apply custom properties (e.g. colors,

names, description) which will not affect the properties of the calendar owner. This behavior

is contrary to Delegation, where any calendar property changes performed by the delegate

will directly affect the owner’s calendar.

Assigning delegates

You can also use an advanced type of sharing — delegation. A delegate has full control over

your calendar and can also create and accept meeting invitations on your behalf.

Delegates are assigned in the account settings, under the Delegation tab. Choose the Edit

button to add a delegate.

Upgrading to Kerio Connect 8.2

Due to the changes in calendar sharing in Kerio Connect 8.2, users with currently delegated

calendars in Apple iCal/Calendar will need to restart their computer. After re-launching

Apple iCal/Calendar, the user will receive an invitation to join each shared calendar that was

previously added using the delegation feature.

http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1502#sect-subscribe
http://kb.kerio.com/1507
http://kb.kerio.com/1507
http://kb.kerio.com/1507
http://kb.kerio.com/1507
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Configuring Microsoft Windows 8 Mail using Ex-

change ActiveSync

Overview

Kerio Connect 8.1 and above supports the ability to synchronize mail, contacts, and calendars

to the Microsoft Windows 8 operating system via the Exchange ActiveSync protocol.

Beginning May 1, 2013, the support of Exchange ActiveSync in Kerio Connect is

available as an add-on. For detailed information, read the Exchange ActiveSync FAQs.

Configuring Kerio Connect

There is no additional configuration necessary to support Exchange ActiveSync (EAS) from

Microsoft Windows 8.

Check the following items:

• Exchange ActiveSync add-on in Kerio Connect

• HTTPS service running and port 443 open on your firewall

• SSL certificate signed by a certification authority to simplify desktop configuration

Installing SSL certificate on your desktop

Users need to install a certificate if Kerio Connect uses a self-signed certificate.

1. Go to the Kerio Connect client login page and click Integration with Windows.

2. Click the Download SSL certificate link.

http://kb.kerio.com/product/kerio-connect/activesync/exchange-activesync-paid-service-faqs-1342.html
http://kb.kerio.com/product/kerio-connect/activesync/exchange-activesync-paid-service-faqs-1342.html
http://kb.kerio.com/product/kerio-connect/activesync/exchange-activesync-paid-service-faqs-1342.html
http://kb.kerio.com/product/kerio-connect/ssl-certificates/configuring-ssl-certificates-in-kerio-connect-1132.html#sect-certrequest
http://kb.kerio.com/product/kerio-connect/ssl-certificates/configuring-ssl-certificates-in-kerio-connect-1132.html#sect-certrequest
http://kb.kerio.com/product/kerio-connect/ssl-certificates/configuring-ssl-certificates-in-kerio-connect-1132.html
http://kb.kerio.com/product/kerio-connect/ssl-certificates/configuring-ssl-certificates-in-kerio-connect-1132.html
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3. Open the file and select Install the certificate.

4. Select either the current user of local machine.

5. Browse for the Certificate store and select Trusted Root Certification Authorities.

6. Confirm.

Configuring Mail on Windows 8

Before you add an Exchange ActiveSync account, you must configure a Microsoft

account (e.g. Hotmail, Windows Live, Outlook.com)

1. In the Mail application, go to Settings → Accounts → Add an account.

2. Select Outlook and Show more details.

3. Fill in the information.

4. Connect.
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Now you can start using the Mail application and synchronize your Kerio Connect emails,

contacts and calendars.
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Synchronizing data with mobile devices

Overview

Kerio Connect supports the ActiveSync which is used to synchronize data between the

computer (server or workstation) and mobile devices.

ActiveSync is a protocol but it is also an application generally included in mobile devices

with Windows Mobile operating systems. It is also a desktop application installed to desktop

computers and used to synchronize data with mobile devices connected to the computer via

a so called “cradle”.

Kerio Connect uses the ActiveSync protocol for direct synchronization of data saved on the

server with data stored in mobile devices. It supports synchronization of email folders,

calendar, contacts and, in case of some devices, also tasks.

Supported mobile devices

Kerio Connect supports several mobile devices. See the product website for an overview of

supported devices.

SSL Certificates

HTTP protocol is used for direct communication between Kerio Connect and mobile devices.

This protocol is not secured and the connection might be wiretapped. This might lead to

misuse of your fragile information such as username and password. For this reason, SSL

(Secure Socket Layer) encryption is often used for traffic to protect the communication from

wiretapping. The HTTP protocol secured by SSL encryption is called HTTPS.

SSL encryption is based on so called SSL certificates. Mailserver disposes of the certificate of

the server against which the certificate in your mobile device is suppose to authenticate. There

are two types of certificates:

• certificates signed by a trustworthy commercial certification authority,

• self-signed certificates.

If your certificate is signed by a commercial authority, there exists a great chance that the

device already includes the certificate and no installation will be required. However, if you use

the Kerio Connect’s self-signed certificate or a certificate signed by an authority not supported

by the device, it is necessary to download and install the certificate in your device. The

instructions for this procedure are provided below..

http://www.kerio.com/connect/mobile/activesync
http://www.kerio.com/connect/mobile/activesync
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To encrypt your traffic by SSL, download and install the certificate before configuring the

ActiveSync.

The following guidelines suppose there is a working Internet connection set in your mobile

device:

1. In the browser, enter your Kerio Connect’s URL to open the Kerio WebMail’s login page.

2. Click on Download SSL certificate.

3. Installation of the certificate should be offered by the device. Install it.

The suggested guidelines work on most of mobile devices. However, on some devices

installation of the certificate is a&nbsp;bit more difficult:

Allowing installation of a root certificate in WM 5.0 Smartphone Edition

The security policy of Smartphone devices with Windows Mobile 5.0 or Windows Mobile 5.0

AKU2 forbids installation of certificates issued by other than trusted certification authorities.

To allow installation of certificates issued by authorities not supported by the particular device

(an internal certificate or the Kerio Connect’s self-signed certificate), it is necessary to install

a mobile device registry editor on the mobile device and use this editor to allow installation

of untrustworthy certificates. One of the options is for example application regeditSTG.zip

(24.01 KB).

In this editor, follow these instructions:

1. Find and download regeditSTG.zip (available for free) and unpack it.

2. Move the editor to the mobile phone (e.g. by using the MS ActiveSync desktop application).

It is necessary that the file is saved in the phone, not on the memory card.

3. On the telephone, click on the file and run it.

4. Run regeditSTG.exe and find HKLM\Security\Policies\Policies

5. Change the following registry items:

• 00001001 overwrite the 2 with 1

• 00001005 overwrite the 16 with 40

• 00001017 overwrite the 128 with 144

6. Now you can download the certificate from the server and install it.
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So called “hard reset” removes the registry changes (it is necessary to

repeat the settings if needed).

SSL encryption in Sony Ericsson devices

If the Kerio Connect’s self-signed certificate is installed, the device does not require

confirmation for each synchronization with the server:

[Security Information ?] The certificate could not be verified. Select

’Certificate details’ to get more information about the certificate. Do

you want to accept the certificate and proceed? [ Yes ] [ No ] [ Details ]

Therefore, it is recommended to install a certificate signed by a trustworthy certification

authority.

Windows Mobile 5.0

In cooperation with Kerio Connect, Windows Mobile 5.0 provides many additional features:

• Windows Mobile 5.0 supports the following folder types:

• email

• calendar

• contacts

• tasks

• Wipe — implementation of the ActiveSync protocol allows the Kerio Connect

administrator remote removal of all synchronized folders and user login data from

the device.

The following options are not supported by Kerio Connect:

• SMS-based Always Up-To-Date (AUTD)

Setting of ActiveSync on Windows Mobile 5.0 is identical with settings on Windows Mobile 5.0

AKU2.

Windows Mobile 5.0 AKU2

In cooperation with Kerio Connect, Windows Mobile 5.0 AKU2 provides these features:

• Windows Mobile 5.0 AKU2 supports the following folder types:
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• email

• calendar

• contacts

• tasks

• DirectPush Technology — this technology allows mobile devices to keep open HTTP(S)

connection with the server. Whenever a new item is received or any change is

performed in any folder, changes are synchronized immediately.

• Kerio Connect supports Global Address Lookup — this feature allows to look up email

addresses in all contact folders available to the particular user (including public

folders).

• Wipe — so called “wipe” allows Kerio Connect administrators reset remote devices.

This reset clears all user data out of the device. Only default files and settings will be

kept on the mobile device.

The following features of Windows Mobile 5.0 AKU2 are not supported by Kerio Connect:

• Setting of security policy from the server (Enforce Security Policy)

• SMS-based Always Up-To-Date (AUTD)

ActiveSync settings in Pocket PC Edition

It is not necessary to install the ActiveSync application since it is included in the Windows

Mobile operating system (it can be found under Start → Programs).

Before the starting to configure, it is necessary to check if connection of the device to network

is set correctly (required for connection to the mailserver). This can be tested for example by

using Internet Explorer to connect to Kerio WebMail.

If the connection does not fail, you can start to set the ActiveSync application:

1. In Start → Programs, use the ActiveSync icon to run the application.

Figure 1 ActiveSync icon
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2. When setting the ActiveSync device for the first time, an informative tips are displayed to

guide you through. Click on the set up your device to sync with it link.

If you already know how to set ActiveSync, open same dialog from Menu → Add Server

Source. This method can be also used whenever you need to change the configuration.

Figure 2 ActiveSync menu

In case that the ActiveSync application has already synchronized data with

another mailserver, remove the settings by clicking on the Delete button in Menu

→ Options.

3. This opens the first page of the configuration wizard used for specification of the Kerio

Connect’s Internet name.

The This server requires an encrypted (SSL) connection option allows encryption of any

traffic between the server and the device. It is highly recommended to keep the option

enabled to protect your connections from debugging and misuse.

To allow the encryption, it is required that an SSL certificate is installed on the device.

If your company uses certificates authorized by a commercial certification authority, it

is possible that your device already includes support for SSL encryption. If the company

uses a certificate generated by Kerio Connect or another internal certificate, it is necessary

to install another certificate on the device.

Once the server name is set and SSL encryption enabled, click on Next to open the

following page of the configuration wizard.

4. On the second page, set your login data:
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Figure 3 ActiveSync — specification of a mailserver and setting secure traffic

Figure 4 ActiveSync — user login data definition

User name

Use this entry to specify the user name used for authentication to Kerio Connect.

Password

Use this entry to specify the password used for authentication to Kerio Connect.
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Domain

Use this textfield to enter the email domain name (usually it is the part of your email

address after the @ symbol).

Save password

If you do not wish to be asked for the login data by each startup of the

synchronization, enable this option. If you want to use the feature of automatic

synchronization, this option is required to be enabled.

Figure 5 ActiveSync — the Advanced dialog box

Besides login data items, the Advanced button is included in this dialog. It

can be used to set optional parameters. The dialog allows to set measures to be

taken in case that a collision occurs during the synchronization.

Collisions might occur when some folders to be synchronized have been changed both on

the server and on the device since the last synchronization. According to the parameters

set here, ActiveSync will either beat the change performed on the server with the one

applied on the device or the other way round. By default, the server beats the device. It is

recommended to keep these settings.

Once the settings are done, click on Next.

5. The following dialog provides a list of all folder types which can be synchronized. Check

only those folders that will be synchronized and leave unchecked or uncheck the others.
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Figure 6 ActiveSync — folder synchronization settings

The Settings button also included in the dialog is active only upon clicking on the Calendar

or E-mail folder and it opens a dialog where synchronization parameters for calendar

and email folders can be set. The Contacts and Tasks folders do not contain any other

parameters.

Calendar Sync Options

Selection of the Calendar folder and a consequent clicking on Settings opens a dialog

with synchronization settings. The dialog includes a menu where it can be set how

old data will be synchronized.

New events will be synchronized without exception. However, to shorten the time

needed for synchronization, it is possible to set the maximum age of events to be

synchronized (it is not necessary to synchronize old data where the information will

not be needed any longer).

By default, data up to two weeks old is synchronized. If you need to synchronized

also older data, change the settings. In such a case, bear in mind that at least the first

synchronization may take longer.

E-mail Sync Options

Selection of the Calendar folder and a consequent clicking on Settings opens a dialog

with synchronization settings. The dialog includes several options to customize

synchronization:
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Figure 7 ActiveSync — calendar synchronization settings

Figure 8 ActiveSync — email synchronization settings

• Include the previous — this option allows to set how old messages will be

synchronized. By default, messages up to three days old are included in the

synchronization.

• Limit e-mail size to — only messages of size up to the value set will be

synchronized.

• Include file attachments — if this option is enabled, attachments are also

included in synchronization.

• Only if smaller than — the value entered in this option sets the maximum

size of email attachments to be synchronized. Larger attachments are

excluded from synchronization.

The settings described above help decrease time needed for synchronization as well as

the load of the synchronization on network connection.

6. Once the settings are done, save the configuration by clicking on Finish. Now, the first

synchronization between the device and Kerio Connect will be started.

During the synchronization, a dialog appears requiring confirmation of appliance of the

security policy. Use the OK button for confirmation, otherwise the synchronization will

not be completed correctly.
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Figure 9 Wipe confirmation

Other ActiveSync settings are focused in your device’s user’s guide.

ActiveSync settings in Smartphone Edition

It is not necessary to install the ActiveSync application since it is included in the Windows

Mobile operating system (it can be found under Start → ActiveSync).

Before the starting to configure, it is necessary to check if connection of the device to network

is set correctly (required for connection to the mailserver). This can be tested for example by

using Internet Explorer to connect to Kerio WebMail.

If the connection does not fail, you can start to set the ActiveSync application:

1. In Start Programs, use the ActiveSync icon to run the application.

Figure 10 ActiveSync icon

2. Click on Menu and select Add Server Source.

Figure 11 ActiveSync menu
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In case that the ActiveSync application has already synchronized data with

another mailserver, remove the settings by clicking on the Delete button in Menu

→ Options.

3. This opens the synchronization’s configuration wizard.

On the first page of the wizard, use the Server address entry to specify the server’s

Internet name.

Figure 12 ActiveSync — specification of a mailserver and setting secure traffic

The This server requires an encrypted (SSL) connection option allows encryption of any

traffic between the server and the device. It is highly recommended to keep the option

enabled to protect your connections from debugging and misuse.

To allow the encryption, it is required that an SSL certificate is installed on the device.

If your company uses certificates authorized by a commercial certification authority, it is

possible that your device already includes support for SSL encryption. If the company uses

a certificate generated by Kerio Connect or a certificate signed by an internal authority, it

is necessary to install another certificate on the device.

Once the server name is set and SSL encryption enabled, click on Next to open the

following page of the configuration wizard.

4. On the second page, set your login data:

User name

Use this entry to specify the user name used for authentication to Kerio Connect.

Password

Use this entry to specify the password used for authentication to Kerio Connect.
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Figure 13 ActiveSync — user login data definition

Domain

Use this textfield to enter the email domain name (usually it is the part of your email

address after the @ symbol).

Save password

If you do not wish to be asked for the login data by each startup of the

synchronization, enable this option. This option is required to be enabled especially

if you want to use the feature of automatic synchronization.

5. The following dialog provides a list of all folder types which can be synchronized. Check

only those folders that will be synchronized and leave unchecked or uncheck the others.

Figure 14 ActiveSync — folder synchronization settings

Synchronization of email and calendar allows additional settings. Select Calendar

or E-mail and click on Menu. In the menu just opened, select Settings. This opens

a&nbsp;dialog providing options in accordance with type of item to be synchronized:
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Figure 15 Folder synchronization settings — Menu

Calendar Sync Options

The Calendar Sync Options dialog includes a menu where is can be set how old data

will be synchronized.

Figure 16 Folder synchronization settings — calendar

New events will be synchronized without exception. However, to shorten the time

needed for synchronization, it is possible to set the maximum age of events to be

synchronized (it is not necessary to synchronize old data where the information will

not be needed any longer).

By default, data up to two weeks old is synchronized. If you need to synchronized

also older data, change the settings. In such a case, bear in mind that at least the first

synchronization may take longer.

E-mail Sync

The E-mail Sync dialog includes two parameters to be customized:

Figure 17 Folder synchronization settings — email
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• Include the previous — this option allows to set how old messages will be

synchronized. By default, messages up to three days old are included in the

synchronization.

• Limit e-mail size to — only messages of size up to the value set will be

synchronized.

The settings described above help decrease time needed for synchronization as well as

the load of the synchronization on network connection.

6. Before closing the wizard, click on the Menu button and select the Advanced option. It

allows setting of optional parameters. The dialog allows to set measures to be taken in

case that a collision occurs during the synchronization.

Figure 18 ActiveSync — the Advanced dialog box

Collisions might occur when some folders to be synchronized have been changed both on

the server and on the device since the last synchronization. According to the parameters

set here, ActiveSync will either beat the change performed on the server with the one

applied on the device or the other way round. By default, the server beats the device. It is

recommended to keep these settings.

Once the settings are done, click on Next and consequently on the Finish button to save

settings.

7. Once the settings are done, save the configuration by clicking on Finish. Now, the first

synchronization between the device and Kerio Connect will be started.

During the synchronization, a dialog appears requiring confirmation of appliance of the

security policy. Use the OK button for confirmation, otherwise the synchronization will

not be completed correctly.

Other ActiveSync settings are focused in your device’s user’s guide.
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Figure 19 Wipe confirmation

Windows Mobile 6.0

In cooperation with Kerio Connect, Windows Mobile 6.0 provides the following features:

• Windows Mobile 6.0 supports the following folder types:

• email

• calendar

• contacts

• tasks

• DirectPush Technology — this technology allows mobile devices to keep open HTTP(S)

connection with the server. Whenever a new item is received or any change is

performed in any folder, changes are synchronized immediately.

• Kerio Connect supports Global Address Lookup — this feature allows to look up email

addresses in all contact folders available to the particular user (including public

folders).

• Wipe — so called “wipe” allows Kerio Connect administrators reset remote devices.

This reset clears all user data out of the device. Only default files and settings will be

kept on the mobile device.

If you perform synchronization via ActiveSync 12, your device will also support:

• HTML emails,

• message flags,

• the “Out of office” feature.
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The following features of Windows Mobile 6.0 are not supported by Kerio Connect:

• Setting of security policy from the server (Enforce Security Policy)

• SMS-based Always Up-To-Date (AUTD)

Setting of ActiveSync on Windows Mobile 6.0 is identical with settings on Windows Mobile 5.0

AKU2.

Nokia Eseries

Nokia Eseries allows folder synchronization by the ActiveSync protocol if the Nokia’s Mail For

Exchange application is installed on the device.

Devices E52, E55, E72 and E75 already have Mail for Exchange installed.

Mail For Exchange with Kerio Connect provide the following options and features:

• Nokia Eseries supports the ActiveSync protocol, version 2.5.

• Nokia Eseries supports synchronization of the following folder types:

• Inbox — other email folders are not synchronized.

• Other folders and subfolders (only Nokia E52 — E75 with integrated Mail for

Exchange).

• Calendar — the default private calendar.

• Contacts — the default private contact folder.

• DirectPush Technology — this technology allows mobile devices to keep open HTTP(S)

connection with the server. Whenever a new item is received or any change is

performed in any folder, changes are synchronized immediately.

• Kerio Connect supports Global Address Lookup — this feature allows to look up email

addresses in all contact folders available to the particular user (including public

folders).

• This version allows installation of the root certificate on the device — this implies that

it is also possible to use the Kerio Connect’s self-signed certificate for encryption.

Mail For Exchange does not support the following features:

• It is not possible to synchronize public and shared folders.

• It is not possible to accept/reject an invitation. Invitations can be viewed in Inbox but

it cannot be manipulated — it does not offer the Accept and Reject buttons and it is

not displayed in the calendar.
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Mail For Exchange Settings

The Mail for Exchange application is not included in the mobile device set. Therefore, it

is necessary to install it. Import and installation of the application is described in the

application’s guide which is available at the Nokia website.

This chapter describes settings for devices Nokia E60 and Mail For Exchange 1.3.0. It

can, therefore, slightly differ on other versions.

1. After installation of Mail for Exchange, locate the application and open it.

Figure 20 Icon of Mail For Exchange 1.3.0

2. In the application, select the Sync mode option.

Figure 21 Mail For Exchange welcome page

3. In the menu just opened, select the Edit profile option.

4. In the Profile menu, select Connection.
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Figure 22 Options → Edit profile

Figure 23 The Edit profile menu

5. This opens a dialog for connection to the server. The first section to be set is the Connec-

tion tab. The following parameters are to be set here:

Figure 24 The Connection dialog
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Exchange server

Enter the server’s internet name or IP address.

Secure connection

The Secure connection option allows encryption of any traffic between the server

and the device. It is highly recommended to keep the option enabled to protect your

connections from debugging and misuse.

To allow the encryption, it is required that an SSL certificate is installed on the device.

If your company uses certificates authorized by a commercial certification authority,

it is possible that your device already includes support for SSL encryption. If the

company uses a certificate generated by Kerio Connect or another internal certificate,

it is necessary to install another certificate on the device.

Now, save settings of the tab.

6. In the Profiles menu, select Credentials. Enter login information used for connection to

your mailbox:

Figure 25 The Credentials dialog

Username

Use the Username textfield to enter username used for connection to the mailbox in

Kerio Connect.

Password

Use the Password textfield to enter password used for connection to the mailbox in

Kerio Connect.

Domain

Use the Domain textfield to enter the name of the email domain (if you are not sure

about this part, contact your administrator).

Save the settings.

7. In the Profiles menu, select Sync content. On this tab, set folders to be synchronized.

The tab also allows selection of preferred store for possible collisions. Collisions might
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occur when some folders to be synchronized have been changed both on the server and

on the device since the last synchronization. In accordance with the settings, either the

changes performed on the server will beat and overwrite the changes in performed on the

device (the Server wins option) or the other way round (the Phone wins option) within

the ActiveSync. By default, the server beats the device. It is recommended to keep these

settings.

Figure 26 The Sync content dialog

8. In the Profiles menu, select Sync schedule. On this tab it is possible to schedule automatic

synchronization:

Figure 27 The Sync Schedule dialog

Peak sync schedule

Sets the synchronization interval for peak time (the time when you need as fresh

information as possible, usually this time includes the working hours).
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Off-peak sync schedule

Sets the synchronization interval for off-peak time (usually at night).

Peak start time

Setting of the peak time start.

Peak end time

Setting of the peak time end.

Peak days

Setting of peak days (all working days are set by default).

9. Return to the Profiles menu and select the Calendar option. On this tab it is possible to

set parameters for automatic synchronization (see figure 27):

Figure 28 The Calendar dialog

Sync calendar back

All upcoming events are included in the synchronization. However, to shorten the

time needed for synchronization, it is possible to set the maximum age of events to

be synchronized (it is not necessary to synchronize old data where the information

will not be needed any longer).

By default, data up to two weeks old is synchronized. If you need to synchronized

also older data, change the settings. In such a case, bear in mind that at least the first

synchronization may take longer.

Initial sync

Before the first synchronization of the server with the device, it is necessary to

remove one of the stores to avoid collisions. The Initial sync option specifies whether

data on the server (Keep items on phone) or on the device (Delete items on phone)

will be removed during the first synchronization.
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10. In the Profiles menu, select the Contacts option. This tab allows setting of solution for

possible initial collision. Before the first synchronization of the server with the device, it is

necessary to remove one of the stores to avoid collisions. The Initial sync option specifies

whether data on the server (Keep items on phone) or on the device (Delete items on

phone) will be removed during the first synchronization.

Figure 29 The Contacts dialog

11. In the Profiles menu, select the Email option. On this tab, it is possible to set parameters

of synchronization of email folders:

Figure 30 The Email dialog

Email address

The option requires entering of the email address.

Show new mail pop-up

Enables/disables new mail notifications.
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Use signature

Allows adding of a footer to email messages.

Signature

Footer definition.

When sending mail

Setting of time when email is sent (immediately or during the upcoming

synchronization).

Sync messages back

All unread messages are included in the synchronization. However, to shorten the

time needed for synchronization, it is possible to set the maximum age of messages

to be synchronized (it is not necessary to synchronize old data where the information

will not be needed any longer).

By default, synchronization is set to messages up to three days old. If you need to

synchronized also older data, change the settings. In such a case, bear in mind that

at least the first synchronization may take longer.

Nokia N73 and N95

Nokia N73 and N95 allows folder synchronization by the ActiveSync protocol if the Nokia’s

Mail For Exchange 1.6.1 or higher is installed on the device.

Mail For Exchange with Kerio Connect provide the following options and features:

• Nokia N73 and N95 supports the ActiveSync protocol, version 2.5.

• Nokia N73 and N95 supports synchronization of the following folder types:

• Inbox — other email folders are not synchronized.

• Calendar — the default private calendar.

• Contacts — the default private contact folder.

• DirectPush Technology — this technology allows mobile devices to keep open HTTP(S)

connection with the server. Whenever a new item is received or any change is

performed in any folder, changes are synchronized immediately.

• Kerio Connect supports Global Address Lookup — this feature allows to look up email

addresses in all contact folders available to the particular user (including public

folders).

• This version allows installation of the root certificate on the device — this implies that

it is also possible to use the Kerio Connect’s self-signed certificate for encryption.
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Mail For Exchange does not support the following features:

• It is not possible to synchronize public and shared folders.

• It is not possible to accept/reject an invitation. Invitations can be viewed in Inbox but

it cannot be manipulated — it does not offer the Accept and Reject buttons and it is

not displayed in the calendar.

RoadSync

Kerio Connect supports the RoadSync 2.0 application developed by DataViz. RoadSync enables

synchronization between Kerio Connect and mobile devices.

RoadSync supports synchronization of the following folder types:

• Email,

• Calendar,

• Contacts,

The RoadSync application can be installed on the following mobile devices:

• Symbian UIQ,

• Symbian S80,

• Symbian S60 3rd Edition,

• Palm OS (synchronization is available for email only),

• Java MIDP 2.0 (synchronization is available for email only),

For details on RoadSync and supported devices, see the DataViz website at

http://www.dataviz.com/.

Apple iPhone

Apple iPhone 2.0

This section addresses both Apple iPhone 3G and Apple iPhone 1.0 with the OS X 2.0 firmware.

In additions to all options available also for OS X 1.0, Apple iPhone with OS X 2.0 supports the

ActiveSync protocol for direct data synchronization. This implies that now Kerio Connect in

cooperation with Apple iPhone 2.0 provides the following options:

• Apple iPhone allows synchronization of:

http://www.dataviz.com/
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• email,

• calendar,

• contacts.

• Apple iPhone fully supports the device clean-up feature, so called “Device Wipe”. In

short, the device can be cleared (deletion of all data and settings) remotely in case that

it gets lost or stolen.

If you happen to lose your Apple iPhone or it gets stolen,

contact your network administrator immediately to get the device wiped

remotely.

• DirectPush Technology — this technology allows mobile devices to keep open HTTP(S)

connection with the server. Whenever a new item is received or any change is

performed in any folder, changes are synchronized immediately.

• Global Address Lookup — this feature allows look-up of email addressed in contact

folders.

Account settings

To configure ActiveSync (Exchange), follow these guidelines:

1. In Apple iPhone, go to Settings → Mail, Contacts, Calendars.

2. Select Add Account.

3. Select the Microsoft Exchange account type.

4. Enter the following account data:

Email

Enter the primary email address consisting of username and domain (e.g.

jflyhigh@company.com, where jflyhigh is a username and company.com is an email

domain).

Server

Enter DNS name of Kerio Connect.

Username

Enter username for login to your Kerio Connect mailbox.
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Password

Enter password for your mailbox.

Description

This is an optional entry. The description is helpful especially if you intend to use

multiple accounts.

Use SSL

This option allows encryption of any traffic between the server and the device. It is

highly recommended to keep the option enabled to protect your connections from

debugging and misuse.

To enable traffic encryption, it is necessary that an SSL certificate is installed in Kerio

Connect. To get the certificate, go to the Kerio WebMail login page in Safari and click

on Download SSL certificate.

5. In the dialog opened, select which folder types will be synchronized. Uncheck only items

you would really not use.

6. Once the settings are saved, the Mail days to sync item appears — open it and set

how old items will be involved in synchronization. This measure helps avoid that the

synchronization takes too long and that too much needless data is downloaded.

At the end, set how often the synchronization will be performed. This can be done in Settings

→ Fetch New Data. On the Advanced tab, you can also find setting of synchronization type

for your Exchange account.

Apple iPhone 3.0

In Apple iPhone OS 3.0, all features of previous Apple iPhone OS versions are available.

Newly, the following features have been introduced for Apple iPhone:

• CalDAV protocol (allows calendar synchronization),

• standard iCalendar (allows to download shared and public calendars for reading),

• LDAP protocol (allows to access contacts via LDAP).

• support for ActiveSync 12.1 (allows direct search in emails stored in Kerio Connect via

Exchange account).

Once the upgrade is completed successfully, it is necessary to

remove and reconfigure the Exchange account, otherwise the device will

keep attempting to connect to Kerio Connect via ActiveSync 2.5
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In addition to features described above, the system introduces other improvements, such as:

• the Copy&Paste method both for text and graphic items during email composition,

• while composing an email message, it is possible to switch the client to the horizontal

position,

• notifications of new email delivered to other folders than the Inbox,

• creating and sending invitations from ActiveSync account (including showing of

availability of individual users),

• notes synchronization with desktop applications Apple Mail and MS Outlook via Apple

iTunes.

For details on individual enhancements and their implementation options, refer to the Apple

website. In the following sections, you will find settings applying to the very communication

with Kerio Connect:

Configuration of CalDAV account

To configure CalDAV account, follow these guidelines:

1. In Apple iPhone, go to Settings → Mail, Contacts, Calendars.

2. Select Add Account → Other → Add CalDAV Account.

3. Enter the following account data:

Server

Enter DNS name of Kerio Connect.

User

Enter username for login to your Kerio Connect mailbox.

Password

Enter password for your mailbox.

Description

This is an optional entry. The description is helpful especially if you intend to use

multiple accounts.

4. Click on Next to open the Unable to Verify Certificate dialog. If you continue, the

connection either fails due to the server’s security policy or it is established successfully

but the traffic is not protected from tapping. Therefore, it is strongly unrecommended

to use unencrypted traffic. To switch to secured connection, click on Cancel and go to

Advanced Settings:

http://www.apple.com/
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Use SSL

This option allows encryption of any traffic between the server and the device. It is

highly recommended to keep the option enabled to protect your connections from

debugging and misuse.

To enable traffic encryption, it is necessary that an SSL certificate is installed in Kerio

Connect. To get the certificate, go to the Kerio WebMail login page in Safari and click

on Download SSL certificate.

Port

Default ports for communication must be changed as follows:

For HTTPS: 8443 → 443 (to enable the Use SSL option, use port 443)

For HTTP: 8008 → 80

The settings apply if standard ports for HTTP protocol are set on

the server. If connection to the server with these settings fails, contact

your network administrator an check that non-standard ports are not

used for Kerio Connect traffic.

Account URL

Enter URL of the calendar account including the port number specified in the Port

entry.

For example, the URL will be as follows for domain company.com and port 80:

• for your personal account:

http(s)//mail.company.com:80/caldav

• for a shared calendar of user wsmith:

http(s)//mail.company.com:80/caldav/users/company.com/wsmith

• for the calendar of the resource car1:

http(s)//mail.company.com:80/caldav/users/company.com/car1

• for public calendar :

http(s)//mail.company.com:80/caldav/users/company.com/.public

To view new calendars, go to the Calendar application by clicking on Calendars. In the list,

simply click on the calendar you want to open.

Subscription to calendars

To subscribe calendar in the iCalendar format, follow these steps:

1. In Apple iPhone, go to Settings → Mail, Contacts, Calendars.

2. Select Add Account → Other → Add Subscribed Calendar.

3. Enter the following account data:
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Server

Insert URL in this pattern: servername/ical

4. If the account authentication fails, check the following items:

Server

Enter URL in a format compatible with calendar subscription. Basic URL follows

this pattern: servername/ical The basic URL can be used to subscribe to the main

calendar of your account. To subscribe to other calendars, use the following (derived)

URL patterns:

servername/ical/users/domain/user@domain — URL modified for the purpose of

subscription to a shared calendar (e.g. mail.company.com/ical/users/company.com/wsmith@company.com).

servername/ical/users/domain/room@domain — URL modified for the purpose of

subscription to a resource calendar (e.g. mail.company.com/ical/users/company.com/meetingroom1@company.com).

Description

This is an optional entry. The description is helpful especially if you intend to use

multiple calendars.

User

Enter username for login to your Kerio Connect mailbox.

Password

Enter password for your mailbox.

Use SSL

This option allows encryption of any traffic between the server and the device. It is

highly recommended to keep the option enabled to protect your connections from

debugging and misuse.

To enable traffic encryption, it is necessary that an SSL certificate is installed in Kerio

Connect. To get the certificate, go to the Kerio WebMail login page in Safari and click

on Download SSL certificate.

Remove alarms

It is recommended to enable this option, as it will not be possible to disable alarms

after having downloaded the calendar to the device.

To view new calendars, go to the Calendar application by clicking on Calendars. In the list,

simply click on the calendar you want to open.

Download of large shared or public calendars via slow connection (GPRS, EDGE) can

result in temporary unavailability of the calendar to other users.
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LDAP client configuration

To configure LDAP account, follow these guidelines:

1. In Apple iPhone, go to Settings → Mail, Contacts, Calendars.

2. Select Add Account → Other → Add LDAP Account.

3. Enter the following account data:

Server

Enter DNS name of Kerio Connect.

User

Enter username for login to your Kerio Connect mailbox.

Password

Enter password for your mailbox.

Description

This is an optional entry. The description is helpful especially if you intend to use

multiple calendars.

The application cannot read some types of SSL certificates, so it is recommended to

connect only via an unsecured version of the LDAP protocol.

LDAP search is available in the Contacts application. Simply click on Groups to go to contact

lists and select an item to view.

Meeting scheduling and availability settings in Exchange account

To create an invitation, follow these instructions:

1. On Apple iPhone, run the Calendar application.

2. Create a calendar event.

3. Enter standard information, such as name and location of the event as well as its start and

end times.

4. Click on Invitees.

5. Enter or select contact of persons to invite and click on Done.

6. Click on Availability.

7. Select free/busy mode of the appointment to be showed in your free/busy calendar.
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Apple iPhone 4.0

In Apple iPhone OS 4.0, all features of previous Apple iPhone OS versions are available.

Newly, Apple iPhone supports synchronization of contacts via the CardDAV protocol.

CardDAV account settings

To configure CardDAV account, follow these guidelines:

1. In Apple iPhone, go to Settings → Mail, Contacts, Calendars.

2. Select Add Account → Other → Add CardDAV Account.

3. Enter the following account data:

Server

Enter DNS name of Kerio Connect.

User

Enter username for login to your Kerio Connect mailbox.

Password

Enter password for your mailbox.

Description

This is an optional entry.

4. Upon clicking on Save, iPhone attempts to establish connection.

By default, iPhone is set to encrypted traffic (HTTPS) on standard ports. If connection over

HTTPS fails, iPhone attempts to connect via HTTP (unsecured connection).

If connection to the server fails, contact your network administrator an check that

non-standard ports are not used for Kerio Connect traffic. If they are, it is necessary to

set ports manually.

Go to Advanced Settings and set the following parameters:

Use SSL

This option allows encryption of any traffic between the server and the device. It is

highly recommended to keep the option enabled to protect your connections from

debugging and misuse.

To enable traffic encryption, it is necessary that an SSL certificate is installed in Kerio

Connect. To get the certificate, go to the Kerio WebMail login page in Safari and click

on Download SSL certificate.

Port

Set ports for HTTP and HTTPS traffic by using information provided by your network

administrator.
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New contacts are located in the Contacts application. To get there, click on the Contacts

button.

CardDAV account can be used for synchronization of the user’s personal contacts — shared

and public contacts are not involved in the synchronization.

Apple iOS

Kerio Connect now comes with an autoconfig tool for iOS systems. This tool enables simple

setting of automatic synchronization of:

• mailboxes

• contacts

• calendars

How to use the autoconfig tool?

1. In a browser running on an iOS system, enter the address of your mailserver. On the

login page, click on Set up my phone (below the login dialog) and then on Mail, Contacts,

Calendars.

Figure 31 iOS configuration
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2. To create an Exchange ActiveSync account, click on Continue.

For your security, it is recommended to use secured connection.

To configure your device with CalDAV, CardDAV and IMAP, use the link

below the Continue button.

3. This opens the installation page. Click on Install to run installation. You will be asked for

your account’s password.

Figure 32 Installation page

You can click on More details to view what will be included in the installation.

4. Once the installation is completed, you can start using your mailbox immediately.
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Configuring Microsoft Windows Phone 8 using Ex-

change ActiveSync

Overview

Kerio Connect 8.0.1 and above supports the ability to synchronize mail, contacts, calendars,

and tasks to Microsoft Windows Phone 8 devices via the Exchange ActiveSync protocol (EAS).

Beginning May 1, 2013, the support of Exchange ActiveSync in Kerio Connect is

available as an add-on. For detailed information, read the Exchange ActiveSync FAQs.

Which data can be synchronized

For detailed information about which data can be synchronized to your mobile device, see the

product pages.

Configuring Kerio Connect

There is no additional configuration necessary to support Exchange ActiveSync (EAS) from

Microsoft Windows Phone 8.

Check the following items:

• Exchange ActiveSync add-on in Kerio Connect

• HTTPS service running and port 443 open on your firewall

The status of configured EAS devices can be viewed from the users dialog once the account

has been successfully added. In the administration interface, go to Accounts → Users, right

click on a user and select More Actions → Mobile Devices. . . .

http://kb.kerio.com/1342
http://kb.kerio.com/1342
http://kb.kerio.com/1342
https://kerio.com/connect/connected/mobile
https://kerio.com/connect/connected/mobile
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Configuring Windows Phone 8

1. Launch the mail application from the home screen.

2. If it is the first time, create a new account. Otherwise, choose add email account from the

menu options.

3. Select advanced setup.
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4. Enter your email address and password and click next.
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5. Select Exchange ActiveSync as the account type.

6. Enter the name of your domain (e.g. feelmorelaw.com) and server address (e.g.

mail.feelmorelaw.com).
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7. Click Sign in.

Now you can synchronize your Windows Phone 8 device with your account.

If you are using a self-signed SSL certificate, you will receive an Untrusted Certificate

warning. Click continue to add the account. To avoid this warning, install a signed SSL

certificate on the Kerio Connect server. For details, refer to Configuring SSL certificates in

Kerio Connect.

http://kb.kerio.com/1132l#sect-certrequest
http://kb.kerio.com/1132l#sect-certrequest
http://kb.kerio.com/1132l#sect-certrequest
http://kb.kerio.com/1132l#sect-certrequest
http://kb.kerio.com/1132l#sect-certrequest
http://kb.kerio.com/1132l#sect-certrequest
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Delegation in Microsoft Outlook 2011

About delegation

Delegation is an advanced type of sharing. A delegate can act on your behalf. A delegate can

act on your behalf — they can send/confirm your event invitations, and/or send/receive your

messages.

Delegating users

In Outlook 2011, delegates must have at least Editor rights to act on your behalf.

With a lower level of rights, you receive the following error message:

Assigning rights to delegates

1. In your account settings, go to section Delegates.

2. Select a delegate and click Set Permissions.
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3. Kerio Connect 8.3.2 and newer — assign the delegate at least the Editor rights to Inbox

and/or Calendar.

Kerio Connect 8..2.0-8.3.1 — assign the delegate at least the Editor rights to both Inbox

and Calendar.
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4. Confirm.
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Installing Kerio Outlook Connector

About Kerio Outlook Connector

Kerio Outlook Connector (Offline Edition) is a Microsoft Outlook extension that you can use

to manage your Kerio Connect email, events, contacts, and tasks in Microsoft Outlook.

The Offline Edition synchronizes all changes with Kerio Connect once you reconnect.

Downloading Kerio Outlook Connector (Offline Edition)

For supported versions of operating systems and Microsoft Outlook, visit Kerio Connect

product pages.

To download the installation package, follow these steps:

1. Open the Integration with Windows page in your browser:

• on the Kerio Connect client login page, click on the Integration with Windows

link, or

• click your name in Kerio Connect client and select Integration with Windows.

2. Click on Download Kerio Outlook Connector.

Installing Kerio Outlook Connector (Offline Edition)

Before you install Kerio Outlook Connector (Offline Edition), install and run at least

once the MS Outlook application.

http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements/


Installing Kerio Outlook Connector

158

A standard installation wizard is used to install Kerio Outlook Connector (Offline Edition).

After the installation, you must create a profile for each user.

Switching from the online version to the offline version of the Kerio Out-

look Connector

Kerio Outlook Connector (Offline Edition) includes a special utility which converts old profiles

to new profiles.

Upgrading Kerio Outlook Connector

If the administrator has turned on automatic updates, MS Outlook will check for new versions

automatically upon each startup.

If a new version is available, we recommend to update Kerio Outlook Connector.

Read article Kerio Updater Service installation for information on how Kerio Technologies has

improved the upgrade process.

Upgrading Microsoft Outlook

When you upgrade or downgrade MS Outlook, you must reinstall Kerio Outlook Connector

manually.

http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/creating-profiles-in-ms-outlook-1465.html#sect-koc2koff
http://kb.kerio.com/product/kerio-connect/installation-and-upgrade/upgrading-kerio-connect-1152.html
http://kb.kerio.com/product/kerio-connect/installation-and-upgrade/upgrading-kerio-connect-1152.html
http://kb.kerio.com/188
http://kb.kerio.com/188
http://kb.kerio.com/188
http://kb.kerio.com/188
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Creating profiles in MS Outlook

About profiles

After installing Kerio Outlook Connector (Offline Edition), or KOFF, you must create user

profiles before using Microsoft Outlook.

For Kerio Connect 8.3 and newer and Microsoft Outlook 2010 and newer, you can add multiple

Kerio Outlook Connector accounts in one profile in Microsoft Outlook. For older versions, a

single Kerio Outlook Connector account is allowed for each profile.

If you install KOFF on a computer with Kerio Outlook Connector, you can convert old

profiles to new ones.

If you are switching to Kerio Connect from another mailserver (e.g. Exchange), you must

create new profiles in MS Outlook.

Creating user profiles

You can create profiles automatically or manually.

Automatic configuration

Kerio Connect has a special tool for automatic configuration of your MS Outlook account.

1. Open the Integration with Windows page in your browser:

• on the Kerio Connect client login page, click on the Integration with Windows

link, or

• click your name in Kerio Connect client and select Integration with Windows.

2. Download the auto-configuration profile creator which is specific for each user account.

http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
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3. Run the profile creator tool.

The tool creates a Microsoft Outlook profile and synchronizes your Kerio Connect account to

Microsoft Outlook.

Manual configuration

To create a profile manually, go to the computer’s Control Panel → Mail and click Show

Profiles:

1. Click Add, enter a name for the profile and confirm.

2. Select Manually configure server settings or additional server types and continue.
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3. Select Other service and Kerio Connect (KOC Offline Edition) and continue.

4. Enter the server name (or IP address) of Kerio Connect, your account name (Kerio Connect

username) and password.

If the user is not from the primary domain, the username must include the domain (e.g.

maison@feelmorelaw.com).

To check the connection, click on Retrieve Info — if the data is correct, the dialog displays

the name and email address of the user.
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5. Confirm.
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Converting old profiles to profiles for Kerio Outlook Connector (Offline

Edition)

1. Install Kerio Outlook Connector (Offline Edition).

2. Run Start → All Programs → Kerio → Outlook Profile Conversion Utility which converts

all Kerio profiles to profiles for Kerio Outlook Connector (Offline Edition).

One workstation is shared by multiple users

Install KOFF only once and run the Outlook Profile Conversion Utility for each user.

Kerio Outlook Connector is installed without connection to Kerio Connect

Run the Outlook Profile Conversion Utility.

To finish the conversion when you connect to the server, follow these steps for each Kerio

profile:

1. In the profiles dialog (in Control Panel → Mail), select the Kerio profile and click on Prop-

erties.

2. Click on User Accounts.

3. On the following page, double-click on the Kerio account and confirm the settings.

Conversion to the Kerio Outlook Connector profile is finished automatically

http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
http://kb.kerio.com/product/kerio-connect/email-clients/kerio-outlook-connector/installing-kerio-outlook-connector-1464.html
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Adding multiple accounts in a single profile in Mi-

crosoft Outlook

Overview

New in Kerio Connect 8.3!

When creating profiles in Microsoft Outlook 2010 and newer, you can now add multiple Kerio

Outlook Connector accounts in a single profile.

Adding additional account to a profile

1. Install Kerio Outlook Connector 8.3 and newer.

2. Create a profile in Microsoft Outlook.

3. Open the profile and click File → Account Settings.

4. On the E-mail tab, click New.

http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1464
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
http://kb.kerio.com/1465
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5. Configure the new account manually.

6. Restart your Microsoft Outlook.

http://kb.kerio.com/1465#sect-createprofilemanual
http://kb.kerio.com/1465#sect-createprofilemanual
http://kb.kerio.com/1465#sect-createprofilemanual
http://kb.kerio.com/1465#sect-createprofilemanual
http://kb.kerio.com/1465#sect-createprofilemanual
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When you compose messages, you can now select from which account you want to send.
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Removing accounts from a profile

To remove accounts from a profile, follow these steps:

1. Open the profile in Microsoft Outlook.

2. Click File → Account Settings

3. On the E-mail tab, select the account you want to delete and click Remove.
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Synchronizing Microsoft Outlook with Kerio Con-

nect

Online and offline modes

Kerio Outlook Connector (Offline Edition) supports both modes, online and offline:

Online mode

is the standard MS Outlook mode which requires connection to Kerio Connect

Offline mode

allows working with MS Outlook without connection to Kerio Connect

This requires all email, events, tasks, etc. are stored in the local message store on the

client station. When you switch to online mode, all new messages, events and tasks are

synchronized with the server’s store automatically.

About synchronization

Kerio Outlook Connect can synchronize any folder in Kerio Connect in one of the following

modes:

• full synchronization of the folder

• synchronization of header and message body in plain text — with this option,

attachments are not downloaded automatically

The default synchronization works as follows:

• Inbox — whole messages are synchronized.

• Other email folders — only message headers and body in plain text are synchronized.

• Events — whole events are synchronized.

• Contacts — whole contacts are synchronized.

• Tasks — whole tasks are synchronized.

• Notes — whole notes are synchronized.

Upon each startup of Microsoft Outlook, Kerio Outlook Connector synchronizes the currently

opened folder first.
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Setting folder synchronization

To enable/disable synchronization and select a synchronization mode of individual folders,

follow these steps:

1. Right-click a folder and select Properties.

2. On tab Folder Synchronization, select the synchronization mode (or enable/disable the

synchronization).

3. Confirm the settings.

If you disable synchronization of a previously synchronized folder, all present items

will remain synchronized.
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Solving synchronization conflicts

Synchronization conflict occurs when a message, event or any other item is changed both on

the server and in Kerio Outlook Connector between synchronization.

If a conflict occurs during the synchronization:

• the item saved on the server overrules the item in Microsoft Outlook (Kerio Outlook

Connector).

• you receive a special message with information about the conflict

The item from Microsoft Outlook is saved in a special folder called Conflicts (available only in

MS Outlook). If you prefer to keep the item in MS Outlook, move it from the Conflicts folder

and replace the synchronized item from the server to the original folder.
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Sorting messages in MS Outlook

About filters

Messages delivered to you Microsoft Outlook via Kerio Outlook Connector (Offline Edition) are

stored in folder Inbox.

If you have additional folders, you can move messages:

• manually — drag messages to folders

• automatically — sort messages using filters

Creating filters

To sort messages to folders automatically, follow these steps to create filters:

1. In MS Outlook on tab Kerio Connect, click Options.

2. Click Filtering Rules.
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3. Create new or edit existing rules.
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Messages may comply with multiple rules. If you want messages to be filtered by the

first rules which matches, select the Stop processing more rules option in the Select the

actions section.

4. Click OK.

Rules are tested from the top downwards. Use the Up and Down buttons to move rules within

the list.
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Subscribing and sharing folders in Microsoft Out-

look

About sharing

In Microsoft Outlook with Kerio Outlook Connector, you can share any folder with other users.

First, you assign sharing rights to users. Second, users subscribe to shared folders.

Sharing folders

1. In Microsoft Outlook, right-click a folder and select Properties.

2. In the Properties dialog, go to tab Folder Sharing.

3. Click the Add button.

4. In the Folder Sharing - Add dialog, select with whom to share the folder and type the

email address.

You can click Address Book to select from a list of users.
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5. Click OK.

Kerio Connect assigns Reader rights by default.

6. Click OK to save the Properties dialog

Changing sharing rights

1. In Microsoft Outlook, right-click a folder and select Properties.

2. In the Properties dialog, go to tab Folder Sharing.

3. Click on a user and select the type of sharing rights from the drop-down menu.



Subscribing and sharing folders in Microsoft Outlook

176

4. Click OK.

Removing sharing

1. In Microsoft Outlook, right-click a folder and select Properties.

2. In the Properties dialog, go to tab Folder Sharing.

3. Select a user and click Remove.

Subscribing to shared folders

Users can subscribe to shared folders by following these steps:

1. In Microsoft Outlook, go to File → Account Settings.

2. Double-click the Kerio Connect account.
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3. Go to tab Other Mailboxes and click Add.

4. In the Attach Mailbox dialog, type the email address of the user who shares their folder

with you.
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5. Click OK and confirm the account settings.

Microsoft Outlook displays the shared folders in the tree under the user name of the folder

owner.
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Using delegation in Microsoft Outlook with Kerio

Outlook Connector

About delegation

Delegation is an advanced typed of sharing. A delegate can act on your behalf. A delegate can

act on your behalf — they can send/confirm your event invitations, and/or send/receive your

messages.

Delegating users

1. Sign in to your profile in Microsoft Outlook and go to tab Kerio Connect.

2. Go to section Delegation.

3. Click Add under the Delegates who can act on my behalf box and select delegates.

4.

New in Kerio Connect 8.3.2!

By default, you allow delegates access to your calendar and Inbox. Click the switch button

next to the delegates name to disable acces to your Inbox (delegates can only send and

accept event invitations).
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5. Save the settings.

You can delegate as many users as you wish.

The delegates can now see your Inbox/Calendar in Microsoft Outlook and can act on your

behalf.



35.2 Delegating users

181



182

Selecting from which address to send messages in

Microsoft Outlook

Overview

New in Kerio Connect 8.3!

With Kerio Outlook Connector 8.3 and newer, you can now select from which address you

send messages in Microsoft Outlook.

The addresses from which you can choose from include:

• your email address

• all your aliases

• addresses from all accounts in your profiles

• address of people you are a delegate of

Selecting the From address

1. Open your profile in Microsoft Outlook.

2. Click New E-mail.

3. Click the From button and select an address.

http://kb.kerio.com/1123
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1598
http://kb.kerio.com/1505
http://kb.kerio.com/1505
http://kb.kerio.com/1505
http://kb.kerio.com/1505
http://kb.kerio.com/1505
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Now you can compose the message and send it from your selected address.
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